PostScript 3 Supplement

@ Windows Configuration
@ Mac OS Configuration
@ Using PostScript 3

(4) Printer Utility for Mac

Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in the "General Settings Guide" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and TrueType are trademarks of Apple Computer,
Inc, registered in the United States and other countries.

Rendezvous is a trademark of Apple Computer Inc.
Bluetooth® is a registered trademark of Bluetooth-SIG Inc. worldwide.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

e The product name of Windows® 95 is Microsoft® Windows 95.

e The product name of Windows® 98 is Microsoft® Windows 98.

* The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

e The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

* The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

e The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition

» The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

e Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.
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1. Windows Configuration

Using the SmartDeviceMonitor for Client Port

Installing SmartDeviceMonitor for Client

iﬁklmportant

3 To install SmartDeviceMonitor for Client under Windows 2000/ XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [SmartDeviceMonitor for Client/Admin].

B The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [l accept the agreement.], and
then click [Next >].

E The SmartDeviceMonitor for Client installer starts.

ﬂ Click the [SmartDeviceMonitor for Client] checkbox, and then click [Next >].
The SmartDeviceMonitor for Client installer starts.

E] Follow the instructions on the display to install SmartDeviceMonitor for
Client.

B click [Finish.
If you are required to restart the computer after installing SmartDeviceMon-
itor for Client, restart the computer.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete. Restart the computer and reinstall other programs or
printer drivers.
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Installing the PostScript 3 Printer Driver (Windows 95/98 / Me - TCP/IP)

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

@ Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].

[3 Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

[3 In the [Available ports:] box, click [Printer Port], and then click [Next >].

ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[E] Specify whether or not to print a test page, and then click [Finish].

m On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

[ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

(B On the [Details] tab, click [Add Port...].
[E] Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

[E Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.



Using the SmartDeviceMonitor for Client Port

[E Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], enter the IP address or host
name of the machine, and then click [OK].

You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

[ﬂ Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

iE Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98 / Me - IPP)

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

E Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

ﬂ In the [Available ports:] box, click [Printer Port], and then click [Next >].
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g Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

m Specify whether or not to print a test page, and then click [Finish].

[ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

[E Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

[E On the [Details] tab, click [Add Port...].

[I] Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

B click pery.

m In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

er's address.

If the server authentification is issued, to enable SSL ( a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http:/ /printer's address/ipp" as the printer's address.

[ﬂ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

iE Click [Detailed Settings] to configure proxy server, IPP user name, and other
settings. Make these settings, and then click [OK].

You can enter "http://printer's address/ipp" as the printer's address.
[ click [ok.

ﬂﬂ Check that the selected port is highlighted in [Print to the following port], and
then click [OK] .

ﬂ] Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.



Using the SmartDeviceMonitor for Client Port

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

iﬁklmportant

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

g Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

ﬂ Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

[3 Click [SmartDeviceMonitor], and then click [Next >].

B Click [TCPAPY, and then click [Search].
A list of printers using TCP/IP appears.

[E Select the printer you want to use, and then click [OK].

Only Erinters that respond to a broadcast from the computer a}lanpear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

m Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to share the printer, and then click [Next >].
[ﬂ Specify whether or not to print a test page, and then click [Next >].
[E Click [Finish].

The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

E Click [Local printer attached to this computer], and then click [Next >].

ﬂ Click [Create a new port:].

ﬂ Click [SmartDeviceMonitor], and then click [Next >].

B crick pery.

m In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

ﬂ] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.



Using the SmartDeviceMonitor for Client Port

m Click [Detailed Settings] to configure proxy server, the IPP user name and oth-
er settings. Specify the necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.
B crick [ok].

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

iE Change the printer name if you want, and then click [Next >].
[E Specify whether or not to print a test page, and then click [Next >].
[ﬂ Click [Finish].

The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - TCP/IP)

i@klmportant

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe”on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

H Click [Next >].

E Click [Local printer attached to this computer.], and then click [Next >].
ﬂ Click [Create a new port:].

E] Click [SmartDeviceMonitor], and then click [Next >].
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g Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to print a test page, and then click [Next >].

@ click [Finish].
The printer driver installation starts.

@ Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - IPP)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

@ Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].
E Click [Local printer attached to this computer.], and then click [Next >].
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ﬂ Click [Create a new port:].

E] Click [SmartDeviceMonitor], and then click [Next >].

B click pieey.

[ﬂ] In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http://printer's address/ipp" as the printer's address.

ﬂ] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

m Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B crick [ok].

[ﬂ Check that the name of the printer driver you want to install is selected, and
then click [Next >].

[E Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[E Specify whether or not to print a test page, and then click [Next >].
W Click [Finish].

The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B select [My Computer], and then click [Next >].
ﬂ Click [Add Port...].
ﬂ Click [SmartDeviceMonitor], and then click [New Port...].

ﬂ Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

g Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

[E] Click [Close] to close the [Printer Port] dialog box.
B Click [Next »].

[ﬂ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[ﬂ Specify whether or not to share the printer, and then click [Next >].
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[E Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

m Restart the computer to complete installation if necessary.

& Note

O A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

iﬁklmportant

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

H Select [My Computer], and then click [Next >].

E Click [Add Port...].

ﬂ Click [SmartDeviceMonitor], and then click [New Port...].

B crick pery.

g In the [Printer URL] box, enter “http://(printer's address)/printer”as the print-

er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

11
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[E] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

ﬂ] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

[ crick [oK].
B click [Close] to close the [Printer Port] dialog box.
0 Click [Next >].

iE Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[E Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

m Specify whether or not to share the printer, and then click [Next >].

[ﬂ Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

m Restart the computer to complete installation if necessary.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95/ 98:

[l Open the [Printers] window from the [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
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Windows 2000 / Windows NT 4.0:

[l Open the [Printers] window from the [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] On the [Ports] tab, click [Configure Port]
The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003:

I] Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

B Click the [Port] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
¢ For TCP/IP, timeout setting can be configured.

@ Note

O If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

@ Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

® Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box
¢ User, proxy, and timeout settings can be configured for IPP.

/O Reference

For information about these settings, see SmartDeviceMonitor for Client
Help.

13



14

Windows Configuration

Using the Standard TCP/IP Port

Installing the PostScript 3 Printer Driver (Windows 2000)

i@klmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next >].

ﬂ Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

E] Click [Standard TCP/IP Port], and then click [Next >].

ﬂ Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[ﬂ] Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

ﬂ] Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[ﬂ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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0 Click [Next >].
iE Specify whether or not to print a test page, and then click [Next >].

@ click.
The printer driver installation [Finish]starts.

& Note

[ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

E Click [Local printer attached to this printer], and then click [Next >].

ﬂ Click [Create a new port:].

ﬂ Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].
g Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

15
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[E] Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

[I] Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[ﬂ Specify whether or not to print a test page, and then click [Next >].

[E Click [Finish].
The printer driver installation starts.
& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows 2000)

i@klmportant

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next >].

E Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

ﬂ Click [LPR Port], and then click [Next >].

g Enter the printer's IP address in the [Name or address of server providing Ipd] box.
[ITJ Enter “Ip” in the [Name of printer or print queue on that server] box, and then click [OK].

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

m Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

B Click [Next >].
m Specify whether or not to print a test page, and then click [Next >].

[E Click [Finish].
The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help. 17
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

iﬁklmportant

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory."

B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Select [My Computer], and then click [Next >].

E Click [Local Printer attached to this computer.], and then click [Next >].

ﬂ Click [Create a new port:].

[3 Click [LPR Port] in [Create a new port], and then click [Next >].

g Enter the printer's IP address in the [Name or address of server providing Ipd] box.
[E Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

B Click [Next »].
[ﬂ Specify whether or not to print a test page, and then click [Next >].
B click [Finish].

The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B select [My Computer], and then click [Next >].

E Click [Add Port...].

 select [LPR Port], and then click [New Port....

B Enter the printer's IP address in the [Name or address of server providing Ipd] box.

g Enter “l1p” in the [Name of printer or print queue on that server:] box, and then
click [OK].

[E] Click [Close] to close the [Printer Port] dialog box.
B Click [Next »].

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

19
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m Specify whether or not to share the printer, and then click [Next >].

iE Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.
[E Restart the computer to complete installation if necessary.

& Note
O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows 95/ 98 / Me)

i@klmportant
O If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

ﬂ Quit all applications currently running.

g Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next >].
ﬂ Click [Network printer], and then click [Next >].
ﬂ Click [Browse].

E] Click the computer name you want to use as a print server in the [Browse for
Printer] window.

g Select the printer you want to use, and then click [OK].
m Check the location of the selected printer is shown, and then click [Next >].

ﬂ] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[E Specify whether or not to print a test page, and then click [Finish].
[B Restart the computer.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000)

iﬁklmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

O If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].
E Click [Network printer], and then click [Next >].

ﬂ Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

B Double-click the computer name you want to use as a print server in the
[Shared printers] window.

ﬂ Select the printer you want to use, and then click [Next >].
[E The printer driver installation starts.

0 Click [Next>].

Select the [Yes] check box to configure the printer as default.
[ click [Finish].

Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

O If you print with a Windows XP or Windows Server 2003 print server, Smart-
DeviceMonitor notification functions may not be possible for the client.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

E Click [A network printer, or a printer attached to another computer] and then click
[Next >].

ﬂ Select [Browse for a printer], and then click [Next >].

B Double-click the computer name you want to use as a print server in the
[Shared printers] window.

g Select the printer you want to use, and then click [Next >].

[E The printer driver installation starts.
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0 Click [Next >].

Select the [Yes] check box to configure the printer as default.
[ click [Finish].

Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

O To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

I] Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.
g Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Network printer server], and then click [Next >].
(3 click [Next>].

ﬂ Double-click the computer name you want to use as a print server in the
[Shared printers] window.



Using as the Windows Network Printer

E] Select the printer you want to use, and then click [Next >].
g Check the location of the selected printer is shown, and then click [Next >].

[E] Change the printer name if you want, and then click [Next >].

ﬂ] Specify whether or not to print a test page, and then click [Finish].
Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server / Remote
Printer

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.
[I In the [Printers] or [Printers and Faxes] window, open the printer properties.
H Click the [PostScript] tab.

& Note

O When using Windows 2000 / XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.

E) Click [Advanced].

ﬂ Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

ﬂ Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

iﬁklmportant
O Make sure that machine is connected to the computer's USB ports using the

USB interface cable.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this machine.

Windows 98 SE / Me - USB

iﬁklmportant
O Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-

dows 98 SE / Me.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

I] Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B Turn on the power of the machine.
ﬂ Click [Next >].

B Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

E Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note
[ When Auto Run starts, click [Exit].
O To disable Auto Run, press the [Shift] key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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E] Specify the location where USB Printing Support is located, and then click
[Next >].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:ADRIVERS\RPCS\WIN9X_ME

ﬂ Check the location, and then click [Next >].
USB Printing Support is installed.

0 click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.

B Click [Next »].

[E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

[B Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

[0 1nsert the CD-ROM into the CD-ROM drive.

& Note
[ When Auto Run starts, click [Exit].

3 To disable Auto Run, press the [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

[E Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

¢ PostScript 3
D:\DRIVERS\PS3\WIN9X_ME\ (Language)\DISK1
[E Check the location, and then click [Next >].
Add Printer Wizard starts.

[ﬂ Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

& Note
O The number after "USB" varies depending on the number of printers connected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

iﬁklmportant

O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

I] Turn off the power of the machine.

g Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

g Turn on the power of the machine.
ﬂ Click [Next >] in the [Found New Hardware Wizard] dialog box.

B Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next >].

E Select the [Specify location] check box, and then click [Next >].
ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note
[ When Auto Run starts, click [Exit].

O To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E] Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

¢ PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language) \DISK1

ﬂ Check the printer driver location, and then click [OK].
[ Click [Next >].

B click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.

& Note
O The number after “USB” varies depending on the number of printers connected.
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Windows XP, Windows Server 2003 - USB

iﬁklmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

[I Turn off the power of the machine.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B Turn on the power of the machine.

I] In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next >].

H To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

& Note
3 If Auto Run starts, click [Cancel], and then [Exit].

E Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

¢ PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language) \DISK1
ﬂ Check the printer driver location, and then click [Next >].
B click [continue].

B ctick [Finish).
If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.
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Troubleshooting for using USB

Problems

Solutions

The machine is not automatically rec-
ognized.

Turn off the power of the machine, reconnect the USB
cable, and then turn it on again.

Windows has already configured the
USB settings.

Open Windows' Device Manager, and then, under [Uni-
versal Serial Bus controllers], remove any conflicting de-
vices. Conflicting devices have a yellow [!] or [?]icon by
them. Take care not to accidentally remove required de-
vices. For details, see Windows Help.

& Note

O When using Windows 2000/XP or Windows Server
2003, an erroneous device is displayed under [USB

Controller] in the [Device Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PostScript 3 Printer Driver (Windows 95/ 98 / Me)

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

(3 Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose printer driver you want to install,
and then click [Next >].

ﬂ In the [Available ports:] box, click [Printer Port], and then click [Next >].

g Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

m Specify whether or not to print a test page, and then click [Finish].

ﬂ] Restart the computer to complete installation.

& Note

[ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.



Printing with Parallel Connection

Installing the PostScript 3 printer driver (Windows 2000)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].

(3 Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

1 select [LPT1] at the [Printer Port] dialog box, and then click [Next >].
E] Select whether or not to share the printer, and then click [Next >].

g Select the name of the machine whose driver you want to install, and then
click [Next >].

m Select whether or not you want to print a test page, and then click [Finish].
The printer driver installation starts.

ﬂ] Restart the computer to complete installation if necessary.

& Note

[ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next »].
E Click [Local printer attached to this computer], and then click [Next >].

ﬂ Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

E] Select the name of the machine whose driver you want to install, and then
click [Next >].

g Click [Close] to close the [Printer Port] dialog box.
[ Click [Next >].
m Change the printer name if you want, and then click [Next >].

[ﬂ Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[B Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.



Printing with Parallel Connection

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

iﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

[l Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.
8 Select an interface language, and then click [OK].
The default interface language is English.

& Note

O The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B select [My Computer], and then click [Next >].

E Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

g Specify whether or not to share the printer, and then click [Next >].

m Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

ﬂ] Restart the computer to complete installation if necessary.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this machine.

iﬁklmportant
O Quit all applications currently running, and do not print during installation.

O Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

O Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

O SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

O This machine can receive print data from one computer at a time only. An
message may appear if jobs from different computers collide.

O If jobs collide, the first received is printed first.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

@ Note

O If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the "1394_00n" port, click [1394_00] as a port during the printer
driver installation.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

ﬂ Connect the machine and computer using the IEEE 1394 interface cable.

B Click [Next >] in the [Found New Hardware Wizard] dialog box.

8 When the message "This wizard will complete the installation for this De-
vice: Unknown" appears, click [Specify a location], and then click [Next >].

ﬂ When the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].

H To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

If Auto Run starts, click [Cancel], and then [EXxit].



Installing the Printer Driver Using IEEE 1394 (SCSI print)

E Click [Browse].
ﬂ Select the printer driver you want to use.

the following location:

¢ PostScript 3
D:ADRIVERS\PS3\WIN2K_XP\ (Language) \DISK1\

B click [open;.
B crick [ok).

If the CD-ROM drive is D, the source files of the printer driver are stored in u

[ﬂ] Follow the instructions.

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers] window. ("n" shows the number of printers connected.)

& Note

O If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not neces-
sary.

O If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

O If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

® When the [Found New Hardware Wizard] dialog box appears, click [Next >].

® When the message "This wizard will complete the installation for this
Device: Unknown" appears, select the [Search for a suitable driver for my de-
vice recommended] check box, and then click [Next >].

® When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

@ When the message "Driver Files Search Results" appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish]."
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Windows XP, Windows Server 2003

iﬁklmportant
[ SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

& Note

O This machine can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

O To install another printer driver after setting the "1394_00n" port, click
[1394_00] as a port during the printer driver installation.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

ﬂ Connect the machine and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

B When the message "Please choose your search and installation option." ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

I] To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

& Note
O If Auto Run starts, click [Cancel], and then [Exit].

ﬂ Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

¢ PostScript 3
D:ADRIVERS\PS3\WIN2K_XP\ (Language) \DISK1\

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ("n" shows the number of printers connected.)



Installing the Printer Driver Using IEEE 1394 (SCSI print)

E Follow the instructions.

& Note

O

O

If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.

If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below

® When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next >].

@ When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

® When the message "The wizard could not find the software on your
computer for.." appears, click [OK].

@ When the message "Cannot Install this Hardware" appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

% SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

Conditions for bidirectional communications
* SPP connection does not support bidirectional communications.
¢ HCRP connection supports bidirectional communications.

< BIP

For BIP connection, a module including PostScript 3 must be installed in
the machine.

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

iﬁklmportant

O To install the printer driver under Windows 2000/ XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrator or Power Users group member.

@ Note

O System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

O For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.



Printing with Bluetooth Connection

I] Start 3Com Bluetooth Connection Manager.

B Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] On the [Tool] menu, click [COM port].

ﬂ Check that the message "Bluetooth Serial Client (COMXx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B click [Close].

(3 on the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
B click the [Ports] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

0 click [oK].
Close the [Printers] window.

% If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:
@ Select the printer you want to use in the [Printers and Fax] box.
@ Click [Connect].

& Note

O To always use the same printer, select the [Always use for this connection]
check box.

/O Reference

For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.

4]
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Configuring Security Mode Settings

I] Start 3Com Bluetooth Connection Manager.

H On the [Tools] menu, click [Security Mode.
The [Security Mode] dialog box appears.

g Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.42 “Printing in the Security Mode”

For all other security modes and custom settings, no password is required.

& Note
O For information about each mode, see the manuals provided with the utility.

O click [oK].
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.42 “Printing in the Security Mode”.

Printing in the Security Mode

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

g The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the ma-
chine. For example, if the serial number is 00A0-001234, the Bluetooth pass-
word is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



If a Message Appears during Installation

If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

For Windows 95 / 98 / Me, Windows 2000 and Windows NT 4.0:

B On the [Start] menu, point to [Settings], and then click [Printers].
g Double-click the Add Printer icon.
B Follow the instructions in Add Printer Wizard.

& Note

O If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is either D:\DRIVERS\PS3\WIN9X_MEN\ (Language)\DISK1,
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1, or D:\DRIV-
ERS\PS3\NT4\ (Language) \DISK1. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

I] On the [Start] menu, click [Printers and Faxes].
B Click [Add a printer].
B Follow the instructions in Add Printer Wizard.

@ Note

O If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.

For Windows XP Home Editions:

I] On the [Start] menu, click [Control Panel].

ﬂ Click [Printers and Other Hardware].

B Click [Printers and Faxes].

ﬂ Click [Install Printer].

H Follow the instructions in Add Printer Wizard.

& Note
O If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

A Reference
For details about making option settings for the printer, see p.63 “Setting Up
Options”.

Set up option settings when bidirectional communications are disabled.

? Limitation

O Under Windows 2000/XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

I] On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

g Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Click the [Accessories] tab.

@ Note

O Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0,
click the [Device Settings] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

B Select the total amount of the memory in [Total memory:], when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

ﬂ Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.



Setting Up the Printer Driver

Setting Up the Printer Driver

Windows 95 /98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

iﬁklmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

& Note

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

E] On the [File] menu, click [Properties].
The printer properties dialog box appears.

I] Make the necessary settings, and then click [OK].
B ciick [ox.

p Reference
For details, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

& Note

O The procedure to open the printer properties dialog box may vary depending on
the application. For details, see the manuals provided with the application you use.

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

[I On the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

A Reference
For details, see the printer driver Help.



Setting Up the Printer Driver

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

iﬁklmportant

O To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].

/O Reference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

ﬂlmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help. 47
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

g Select the printer you want to use in the [Select Printer] list.

B On the [Preferences] tab, make the necessary settings, and then click [Print]
to start printing.

A Reference
For details, see the printer driver Help.



Setting Up the Printer Driver

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties u

ﬁklmportant

O To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].

/O Reference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

iﬁklmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

E] On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help. 49
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

g Select the printer you want to use in the [Select Printer] list.

B On the [Preference] tab, make the necessary settings, and then click [Print] to
start printing.

A Reference
For details, see the printer driver Help.



Setting Up the Printer Driver

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

i@klmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

[l On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears .

B Click the icon of the printer you want to use.

E] On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

/O Reference
For details, see the printer driver Help.

Making printer default settings - Default

i@klmportant
O To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears. 51
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

& Note

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B On the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].

ﬂ Click [OK] to start printing.

A Reference
For detalils, see the printer driver Help.
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2. Mac OS Configuration

Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac
0S 9.1, see the manual of the Mac OS you are using for details

ﬂlmportant
O For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

& Note

O The PostScript 3 printer driver is stored in the following folder on the CD-
ROM.

Mac OS 8 and 9:PS Driver: (language) :Diskl

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

I] Insert the CD-ROM into the CD-ROM drive.

g Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

O bouble-click the [PS Driver] folder.

H Double-click the folder of the language you use.

E Open [Disk1], and then double-click the installer icon.

ﬂ Follow the instructions on the screen.
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PPD Files

[l Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

8 Double-click the [Printer Descriptions] folder.

ﬂ Double-click the folder of the language you are using.
B open the [DISK1] folder.

E Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

ﬂ Restart the Mac OS.

Setting Up PPD Files

ﬂlmportant
O Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

ﬂ On the [Apple] menu, click [Chooser].
B Click the Adobe PS icon.

8 In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

ﬂ Click [Create].

H Click the printer you want to use, and then click [Setup].

A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.55 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.
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Setting Up Options

ﬂ On the [Apple] menu, click [Chooser].
B Click the Adobe PS icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

ﬂ Click [Configure].
A list of options appears.

ﬂ Select the option you want to set up, and then select an appropriate setting
for it.

(3 ciick [ok).
The list of options closes.
U crick fox.
The [Chooser] dialog box appears.

B Close the [Chooser] dialog box.

& Note

O If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Installing Adobe Type Manager

i@klmportant
O Quit all applications currently running before installation. Install ATM after
you restart the computer.

[I Start a Mac OS.

g Insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM drive con.

ﬂ Double-click the [Mac OS 8 and 9] folder.

B Double-click the [ATM] folder.

E Double-click the ATM 4.6.2 installer icon.

ﬂ Follow the instructions on the screen.
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E] When the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

g On the [Apple] menu, open [Control Panel], and then click [~ATM].
m The ATM control panel opens.

& Note

O For details about installation, see the operating instructions in the ATM
folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-
ROM.

[I Start a Mac OS.

B 1nsert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

B Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

ﬂ Double-click the [Mac OS 8 and 9] folder.
H Double-click the [Fonts] folder.
(3 Double-click the [Screen font] folder.

d Double-click the [TrueType] or [Typet] folder.
Select the font type you want to use.

E] Copy the fonts you want to install in [System Folder].
A confirmation message appears.

B crick [ok).
The fonts are installed.

[E Restart the Mac OS.
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Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

I] Open [Control Panel], and then double-click the AppleTalk icon.
g On the [Connect via:] pop-up menu, click [Ethernet].

B If you change zones, select a name on the [Current zone:] pop-up menu.
ﬂ Close the AppleTalk control panel.

H Restart the computer.

& Note

O The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

O Confirm the Connection to the Printer with TCP/IP

/O Reference

For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk, USB and
TCP/1IP.

Follow the procedure below to configure Mac OS X 10.3.6. If you are not using
Mac OS X 10.3.6, see the manual of the Mac OS X you are using for details.

i@klmportant
O For Mac OS X 10.1 or higher.

& Note
O The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

i@klmportant
O You need an administrator name and a password (phrase). For details, con-
sult your network administrator.

6 insert the CD-ROM into the CD-ROM drive.
ﬂ Double-click the CD-ROM drive icon.

E) Double-click the [Mac 0S X] folder.

ﬂ Double-click the [Mac OS X PPD Installer] folder.
ﬂ Double-click the installer icon.

E Follow the instructions on the screen.

Setting Up the PPD File

ﬂ Start Printer Setup Utility.

B click [Add].
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

B Select the PPD file for the model you are using from the [Printer Model:] pop-
up menu, and then click [Add].
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Setting Up Options

iﬁklmportant
O No printer option settings can be made under Mac OS X. No new settings for
options not installed can be made.

Using USB Interface g

Follow the procedure below to set up USB connection.

[l Start Printer .
B click [Add].
B Click [USB] on the pop-up menu.

The connected printer appears.

ﬂ Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
A list of printer types appears.

B Select the connected printer from the list of printer models, and then click
[Add].

B Close the [Printer List] dialog box, and then quit Printer Setup Utility.

& Note

O When printing with a USB connection to a Macintosh computer, printer
language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

O USB2.0 can be used only with Mac OS X 10.3.3 or higher.
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Using Rendezvous

Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3
or higher. Ethernet, wireless LAN and IEEE 1394 (IP over 1394) connections can
also be used.

[I Start Printer Setup Utility.
B ciick [Add].

B Click [Rendezvous] on the pop-up menu.
The connected printer appears.

ﬂ Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.

A list of printer types appears.

ﬂ Select the name of the connected printer from the list of printer models, and
then click [Add].

E Close the [Printer List] dialog box, and then quit Printer Setup Utility.

& Note

O When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-

ing.

Changing to EtherTalk

i@klmportant
O You need an administrator name and a password (phrase). For details, con-
sult your network administrator

Follow the procedure below to configure a Mac OS X to use EtherTalk.

£ Reference
For information about installing applications required for EtherTalk, see the
Mac OS manuals.

[l Open [System Preference], and then click the Network icon.
B Click the [AppleTalk] tab.
E] select the [Make AppleTalk Active] check box.

ﬂ To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.

H When the settings are made, click [Apple Now].



Configuring the Printer

Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Setting Up Options

To use installed options correctly, first set up the printer driver. If the options are
not recognized, you cannot use them, even though they are physically installed.
The procedure to set up a printer driver varies depending on the operating system.

p Reference

See p.44 “Making Option Settings for the Printer”, p.55 “Setting Up Options”
or p.59 “Setting Up Options” for the installation method appropriate to your
printing environment.

< Windows
You can set up any of the options using the following tabs:

Windows 95 / 98 / Me [Options] on the [Accessories] tab.

Windows 2000 / XP, [Installable Options] on the [Device Settings] tab.

Windows Server 2003

Windows NT 4.0 [Installable Options] on the [Device Setting] tab in the
Properties dialog box.

Mac OS For ethernet, [Chooser] on the Apple Menu. For USB,
[Change Setup] from the [Printing] menu to open the
Desktop printer.

Mac OS X This function is not available.

& Note

O To set up options, access the printer driver from Windows. You cannot set
up options if you access the printer driver from an application.

? Limitation

O If your system is Windows 2000, Windows XP Professional, or Windows
Server 2003, changing printer driver settings requires Manage Printers
permission. Members of Administrators and Power Users groups have
Manage Printers permission by default. When you change printer driver
settings, log on with an account that has Manage Printers permission.

O If your system is Windows NT 4.0, changing printer driver settings re-
quires Full Control access permission. Members of Administrators, Server
Operators, Print Operators, and Power Users groups have Full Control
permission by default. When you change printer driver settings, log on
with an account that has Full Control permission.

O If you are using Adobe Page Maker 6.0, 6.5, or 7.0 with Windows 95 / 98 /
Me / 2000 / XP, Windows Server 2003, or Windows NT 4.0, you have to
set up options in the Adobe PageMaker's print dialog box.

Mac OS
You can set up all options using the [Chooser] dialog box.

7
°o

? Limitation
O If you are using Mac OS X, this functions cannot be used. 63
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Printing a Document

This documentation describes the specific printer functions and menus that are
added by installing the PPD file. For more information about the functions and
menus of the Windows 95 / 98 / Me PostScript printer driver, see the printer
driver's Help.

E Preparation

On a Macintosh, Mac OS 8.6 or higher (Mac OS X Classic environment is sup-
ported.), or Mac OS X 10.1 or higher is required.

? Limitation

O If you are using Mac OS X 10.1.x, the following functions cannot be used:
¢ Sample Print
e Locked Print
e Hold Print
e Stored Print
¢ Document Server
e User Code

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

O “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the
version, [Features x] is displayed as [Set x] (x is a number). Make adjustments
according to the version you use.

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Job Type:] on the [Setup] tab.

Windows 2000 / XP, [Job Type:] on the [Job Log] tab in the Printing Preferences

Windows Server 2003 dialog box.

Windows NT 4.0 [Job Type:] on the [Job Log] tab in the Document Defaults
dialog box.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

< Normal

Select this for normal printing. The print job starts immediately after the print
command is given.

& Note

O Under Windows 95 / 98 / Me, if you want to use an User ID, click the [De-
tails...] button.
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Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the
machine's control panel. You can also delete the saved job.

® Limitation

O Applications with their own drivers, such as PageMaker, do not support
this function.

& Note
O The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-
acters.

O Entering the “User ID” helps you distinguish your print job from others.

p Reference

For details about how to use Sample Print, see p.66 “How to Use Sample
Print”.

Locked Print
Use this function to save documents in the machine memory with a pass-
word, and then edit and print them as you want.

? Limitation

O Applications with their own drivers, such as PageMaker, do not support
this function.

@ Note

O The “User ID” can contain to eight alphanumeric (a-z, A-Z, 0-9) characters.
The “Password” must be 4-8 digits.

O Entering the “User ID” helps you distinguish your print job from others.

p Reference

For details about how to use Locked Print, see p.74 “How to Use Locked
Print”.

Hold Print

Use this function to temporarily hold a file in the machine, and print it from
the computer or the machine's control panel later.

? Limitation
O Applications with their own drivers, such as PageMaker, do not support
this function.

& Note

O The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-
acters.

O Entering the “User ID” helps you distinguish your print job from others.

A Reference
For details about how to use Hold Print, see p.81 “How to Use Hold Print”.
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% Stored Print
Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

? Limitation
O Applications with their own drivers, such as PageMaker, do not support
this function.

& Note
O The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-
acters.The “Password” must be 4-8 digits.

O You can assign a password to a saved document, but password assignment
is not mandatory.

O Entering the “User ID” helps you distinguish your print job from others.

p Reference

For details about how to use Stored Print, see p.87 “How to Use Stored
Print”.

<+ Document Server
Use this function to store hard disk documents that you want to print as well
as documents you might want to later combine or process for printing. For
details about the Document Server function, see "Accessing the Document
Server", Printer Reference.

? Limitation
O Applications with their own drivers, such as PageMaker, do not support
this function.

How to Use Sample Print

Follow the procedure below to print a document using the Sample Print function.

Windows 95 /98 / Me

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver automatically collates Sample Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

ﬂ In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer, and then click [Properties].
E] Click the [Setup] tab.
O 1n the [Job Type:] list, click [Sample Print].



Printing a Document

B click [petails...

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

& Note
O The user ID associates the user with his / her jobs.

U crick [oK].
ﬂ Click [OK] to close the printer properties dialog box.

g Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.

The sample print job is sent to the machine and one set is printed.
[E] Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

[ on the machine's control panel, press the [ Printer] key to display the printer
screen.

[ﬂ Press [Print Jobs].

L3
AL | AT | AT | As |cmsi

R Paper Ty S |IH G20 o[3u o4w [

B b Lists & Enor Log
Print Jobs 1l Enor Log 1

[B Press [Sample Print Job List].
A list of sample print files stored in the machine appears.

01/12 23:10 1234, ixt

2] test 01/12 23:10 123443t

The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.
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[I] Select the file you want to print by pressing it.
A list of the print files stored in the machine appears.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear Alll].

O To view details about a selected print file, press [Details].
[E Press [Print] to change the number of sets to be printed.

m Enter the new number of sets using the number keys.

@ Are you sure you want to print the follawing?

User ID: test
File Name: 1234, tt

The set quantty can be changed
1> <198

If you do not want to change the set quantity, perform the following step.

& Note
O You can enter up to 999 sets.

O Press [Clear/Stop] to correct any entry mistakes.
O When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.
m Press [Yes].
The remaining sets are printed.

& Note
O Press [No] to cancel printing.

O When printing finishes, the stored file is deleted.

O To cancel printing, press [EXit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O If there is a print job outstanding, this is printed before the sample print job.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver automatically collates Sample Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer, and then click [Properties].

&P Note

O If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.

O If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

E] Click the [Job Log] tab.
ﬂ In the [Job Type:] list, click [Sample Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

& Note
O The user ID associates the user with his / her jobs.

E Click [OK] to close the printer properties dialog box.

& Note
O If you are using Windows 2000, perform the following steps.

ﬂ Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.

The sample print job is sent to the machine, and one set is printed.

ﬂ Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

g On the machine's control panel, press the [ Printer] key to display the printer
screen.
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[ Press [Print Jobs].

»-Paper Tray Situs |||=| G20 O[3w Glaw §] &1
A

4|1 A3 | A3 (A4

[ Press [Sample Print Job List].

A list of sample print files stored in the machine appears.

Selert files.

User ID Date (Time File Neme o
S
U 737 T7ad, at ] ‘
Sam es 01712 23:10 1234 ixt [
[Biror Test 0117 7310 1780, ] | Frid ]
B

The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

m Select the file you want to print by pressing it.
A list of print files stored in the machine appears.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear All].

O To view details about a selected print file, press [Details].
[ﬂ Press [Print] to change the number of sets to be printed.

[ﬂ Enter the new number of sets using the number keys.

@ e you sure you wart to prirt the folloving?

User ID: Lest
File Name: 1234, 4t

The set quantity can be changed
19 <1-398=

If you do not want to change the set quantity, perform the following steps.
& Note

O You can enter up to 999 sets.

O Press [Clear/Stop] to correct any entry mistakes.

O When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.
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[E Press [Yes].
The remaining sets are printed.

& Note
O Press [No] to cancel printing.

O When printing finishes, the stored file is deleted.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O If there is a print job outstanding, this will be printed before the sample
print job.

Mac OS / Mac OS X

? Limitation
O If you are using Mac OS X 10.1.x, this function cannot be used.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Set the number of copies to two or more.
The sample print job is sent to the machine, and one set is printed.

B In the pop-up menu, click [Job Log].
ﬂ On the [Job Type:] pop-up menu, select [Sample Print].

B In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

& Note
O The user ID associates the user with his / her jobs.

E Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

ﬂ On the machine's control panel, press the [ Printer] key to display the printer
screen.
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B press [Print Jobs].

»-Paper Tray Situs |||=| G20 O[3w Glaw §] &1
A

4|1 A3 | A3 (A4

£ press [sample Print Job List].

A list of sample print files stored in the machine appears.

Selert files.

User ID Date (Time File Neme o
S
U 737 T7ad, at ] ‘
Sam es 01712 23:10 1234 ixt [
[Biror Test 0117 7310 1780, ] | Frid ]
B

The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

[E] Select the file you want to print by pressing it.
A list of print files stored in the machine appears.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear All].

O To view details about a selected print file, press [Details].
ﬂ] Press [Print] to change the number of sets to be printed.

[ﬂ Enter the new number of sets using the number keys.

@ e you sure you wart to prirt the folloving?

User ID: Lest
File Name: 1234, 4t

The set quantity can be changed
19 <1-398=

If you do not want to change the set quantity, perform the following steps.
& Note

O You can enter up to 999 sets.

O Press [Clear/Stop] to correct any entry mistakes.

O When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.
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[B Press [Yes].
The remaining sets are printed.

& Note
O Press [No] to cancel printing.

O When printing fiishes, the stored file is deleted.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O If there is a print job outstanding, this is printed before the sample print job.

Deleting a Sample Print File

If a printed document is not as required, you can delete the Sample Print file.

B on the machine's control panel, press the [ Printer] key to display the printer
screen.

g Press [Print Jobs].
A list of print files stored in the machine appears.

B press [stored Print Job List].
A list of sample print files stored in the machine appears.

ﬂ Select the file you want to delete by pressing it.

& Note
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted jobs again.
O Only one file can be selected at a time.

B Press [Delete].
A confirmation screen appears.

E Press [Yes] to delete the file.
After the file is deleted the printer screen reappears.

& Note
O Press [No] to cancel the delete request.
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How to Use Locked Print

Follow the procedure below to print a document using the Locked Print function.

Windows 95 /98 / Me

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver automatically collates Locked Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

[I In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

ﬂ Select the printer, and then click [Properties].
E] Click the [Setup] tab.

ﬂ In the [Job Type:] list, click [Locked Print].

B click [petails...].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box.

& Note
O The user ID associates the user with his / her jobs.

U ciick [ok).
E] Click [OK] to close the printer properties dialog box.
g After making the necessary settings, click [OK] to close the [Print] dialog box.

The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

[ on the machine's control panel, press the [ Printer] key to display the printer
screen.

ﬂ] Press [Print Jobs].

A4 |'A3 | A3

s [1e Gf2u O3w ofaw O] &1
A4 |camsie

A list of print files stored in the machine appears.
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[B) Press [Locked Print Job List].

A list of locked print files stored in the machine appears.

Date /Tine Betile
test 01412 23t electe Select AllJabs
1
D o e |38 et T g "
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|

The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

[ﬂ Select the file you want to print by pressing it.

& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear All].

O To view details about a selected print file, press [Details].
m Press [Print].

The password screen appears.

@ Enter the passward with the Nurber keys, then press [OK]

[E Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
& Note

O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O When multiple print files are selected, the machine prints only files that

correspond to the entered password. The number of files is displayed on
the confirmation screen.

[ press [Yes].
A locked file is printed.
& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver automatically collates Locked Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer, and then click [Properties].

&P Note

O If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.

O If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].
E] Click the [Job Log] tab.
ﬂ In the [Job Type:] list, click [Locked Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

& Note
O The user ID associates user with his / her jobs.

E Click [OK] to close the printer properties dialog box.

& Note
O If you are using Windows 2000, perform the following steps.

ﬂ Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

B on the machine's control panel, press the [ Printer] key to display the printer
screen.



Printing a Document

B press [Print Jobs].
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A list of print files stored in the machine appears.

[ press [Locked Print Job List].

A list of locked print files stored in the machine appears.

Select files.
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The following items also appear:
¢ User ID: The user ID set up by the printer driver.
¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.
ﬂ] Select the file you want to print by pressing it.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear All].

O To view details about a selected print file, press [Details].
[ﬂ Press [Print].

The password screen appears.

@ Erter the passvord with the Nurnber keys, then press [OK]
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[B Enter the password using the number keys, and then press [OK].
A confirmation screen appears.

& Note

O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O When multiple print files are selected, the machine prints only files that
correspond to the entered password. The number of files is displayed on
the confirmation screen.

@ press [Yes].
The locked file is printed.
& Note

O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

Mac OS / Mac OS X

? Limitation
O If you are using Mac OS X 10.1.x, this function cannot be used.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

ﬂ In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

g In the pop-up menu, click [Job Log].
B On the [Job Type:] pop-up menu, click [Locked Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box.

& Note
O The user ID associates the user with his / her jobs.

H After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

E On the machine's control panel, press the [ Printer ] key to display the printer
screen.



Printing a Document

 press [Print Jobs].
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A list of print files stored in the machine appears.

B press [Locked Print Job List].

A list of locked print files stored in the machine appears.

Select files.
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The following items also appear:
¢ User ID: The user ID set up by the printer driver.
¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.
g Select the file you want to print by pressing it.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted print job again. To clear all se-
lections, press [Clear All].

O To view details about a selected print file, press [Details].
m Press [Print].

The password screen appears.

@ Erter the passvord with the Nurnber keys, then press [OK]
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ﬂ] Enter the password using the number keys, and then press [OK].
A confirmation screen appears.

& Note

O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O When multiple print files are selected, the machine prints only files that
correspond to the entered password. The number of files is displayed on
the confirmation screen.

[ press [Ves].
The locked file is printed.
& Note

O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

Deleting a Locked Print File

If a printed document is not as required, you can delete the Locked Print file.

B on the machine's control panel, press the [ Printer] key to display the printer
screen.

g Press [Print Jobs].
A list of print files stored in the machine appears.

B press [Locked Print Job List].
A list of locked print files stored in the machine appears.

ﬂ Select the file you want to delete by pressing it.

& Note

O Press [4 Prev.] or [V Next.] to scroll through the list.
O To cancel a selection, press the highlighted job again.
O Only one file can be selected at a time.

ﬂ Press [Delete].
A password screen appears.



Printing a Document

E Enter the password using the number keys, and then press [OK].
A confirmation screen appears.

& Note

O A confirmation screen will reappear if the password was entered incorrect-
ly. Press [OK] to enter the password again.

O When multiple files are selected, the machine deletes only files that corre-
spond to the entered password. The number of files to be deleted is dis-
played on the confirmation screen.

1 press [Yes].
After the file is deleted, the printer screen reappears.

& Note
O Press [No] to cancel the delete request.

How to Use Hold Print

Follow the procedure below to print a document using the Hold Print function.

Windows 95 /98 / Me

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver automatically collates Hold Print jobs by de-
fault.If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

ﬂ In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer, and then click [Properties].
E] Click the [Setup] tab.

ﬂ In the [Job Type:] list, click [Hold Print].

H Click [Details...].

B In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters. File Name can also be set.

& Note
O The user ID associates the user with his / her jobs.

U crick [ox.
m Click [OK] to close the printer properties dialog box.
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g After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Hold Print File”.

[ on the machine's control panel, press the [ Printer] key to display the printer
screen.

ﬂ] Press [Print Jobs].
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A list of the print files stored in the machine appears.

[B) Press [Hold Print Job List].
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The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note
O Depending on the security settings, certain print jobs may not be displayed.

[ﬂ Select the file you want to print by pressing it.

& Note
O To select all print jobs, press [Select All Jobs].

O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].

[ﬂ Press [Print].
A confirmation screen appears.



Printing a Document

[E Press [Yes].
The hold print file is printed.

& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O When printing is finished, the stored file is deleted.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

& Note
O If the application has a collate option, make sure it is not selected before send-

ing a print job. The printer driver automatically collates Hold Print files by
default. If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.

& Note

O If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.

O If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].
E] Click the [Job Log] tab.
O 1 the [Job Type:] list, click [Hold Print].

B In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters. File Name can also be set.

& Note
O The user ID associates the user with his / her jobs.

E Click [OK] to close the printer properties dialog box.

& Note
O If you are using Windows 2000, perform the following steps.

ﬂ Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.

To delete the document, see p.87 “Deleting a Hold Print File”. 83
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E] On the machine's control panel, press the [ Printer] key to display the printer
screen.

B press [Print Jobs].
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The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note

O Depending on the security settings, certain print jobs may not be displayed.

ﬂ] Select the file you want to print by pressing it.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].
m Press [Print].

A confirmation screen appears.

[B Press [Yes].
The hold print file is printed.
& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

84 O When printing finishes, the stored file is deleted.



Printing a Document

Mac OS / Mac OS X

? Limitation
O If you are using Mac OS X 10.1.x, this function cannot be used.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

[l From an application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g In the pop-up menu, click [Job Log].
B On the [Job Type:] pop-up menu, click [Hold Print].

ﬂ In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters. File Name can also be set. File Name can also be set.

& Note
O The user ID associates the user with his / her jobs.

ﬂ After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Hold Print File”.

[ on the machine's control panel, press the [ Printer] key to display the printer
screen.

ﬂ Press [Print Jobs].
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A list of print files stored in the machine appears.
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B Press [Hold Print Job List].

A list of hold print files stored in the machine appears.

Select files.
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The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note
O Depending on the security settings, certain print jobs may not be displayed.

g Select the file you want to print by pressing it.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].

m Press [Print].

A confirmation screen appears.

ﬂ] Press [Yes].
The hold print file is printed.
& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O When printing is completed, the stored file is deleted.



Printing a Document

Deleting a Hold Print File

If a printed document is not as required, you can delete the Hold Print file.

ﬂ On the machine's control panel, press the [ Printer ] key to display the printer
screen.

B press [Print Jobs].
A list of the print files stored in the machine appears.

EJ press [Hold Print Job List].
A list of Hold Print files stored in the machine appears.

& Note
O Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete by pressing it.
A confirmation screen appears.

B Press [Yes].
After the file is deleted, the printer screen reappears.

& Note
O Press [No] to cancel the delete request.

How to Use Stored Print

Follow the procedure below to print a document using the Stored Print function.

Windows 95/ 98 / Me

& Note

O If the application has a collate option, make sure it is not selected before send-
ing a print job.The printer driver collates the Stored Print files by default. If a
collate option is selected from the application's Print dialog box, there may be
more prints than required.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].
E) Click the [Setup] tab.

O 1 the [Job Type:] list, click [Stored Print].

B click [petails..].
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E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

& Note
O The user ID associates the user with his / her jobs.

O You can assign a password to a saved document, but password assignment
is not mandatory.

O The same password must be entered when printing or deleting.
U crick [oK].
ﬂ Click [OK] to close the printer properties dialog box.
ﬂ After making the necessary settings, click [OK] to close the [Print] dialog box.

The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

[ on the machine's control panel, press the [ Printer] key to display the printer
screen.

ﬂ] Press [Print Jobs].
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The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note
O Depending on the security settings, certain print jobs may not be displayed.



Printing a Document

[B Select the file you want to print by pressing it.
& Note
O To select all print jobs, press [Select All Jobs].
O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].

0 Press [Print].

A confirmation screen appears.

& Note
O If you have already set a password, proceed to the following step.

[E Enter a password using the number keys on the password screen, and then
press [OK]

@ Erter the passvord with the Nurnber keys, then press [OK]

& Note

O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O If you have not set the password, proceed to the following step.

m Press [Yes].
The stored print file is printed.

& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O The Stored Print files sent to the machine are not deleted unless you delete
them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.94 “Deleting a Stored Print File”.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

& Note
O If the application has a collate option, make sure it is not selected before send-

ing a print job. The printer driver automatically collate Stored Print files by
default. If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.

& Note

O If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.

O If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].
E] Click the [Job Log] tab.
ﬂ In the [Job Type:] list, click [Stored Print].

B In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

& Note
O The user ID associates the user with his / her job.

O You can assign a password to a saved document, but password assignment
is not mandatory.

O The same password must be entered when printing or deleting.
E Click [OK] to close the printer properties dialog box.

& Note
O If you are using Windows 2000, perform the following steps.

ﬂ Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

B on the machine's control panel, press the [ Printer] key to display the printer
screen.



Printing a Document

B press [Print Jobs].
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The following items also appear:
¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note

O Depending on the security settings, certain print jobs may not be displayed.
ﬂ] Select the file you want to print by pressing it.

& Note

O To select all print jobs, press [Select All Jobs].

O Press [4 Prev.] or [¥ Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].
[ Press [Print].
A confirmation screen appears.
& Note
O If you have already set a password, proceed to the following step.
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[B Enter a password using the number keys on the password screen, and then
press [OK]

& Note
O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O If you have not set the password, proceed to the following step.

[ press [Yes].
The stored file is printed.

& Note

O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O Stored Print files sent to the machine are not deleted unless you delete
them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.94 “Deleting a Stored Print File”.

Mac OS / Mac OS X

? Limitation

O If you are using Mac OS X 10.1.x, this function cannot be used.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g In the pop-up menu, click [Job Log].
B On the [Job Type:] pop-up menu, click [Stored Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

& Note
O The user ID associates the user with his / her jobs.

O You can assign a password to a saved document, but password assignment
is not mandatory.

O The password must be entered when printing or deleting.



Printing a Document

B After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

E On the machine's control panel, press the [ Printer ] key to display the printer
screen.

1 press [Print Jobs].
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The following items also appear:

¢ User ID: The user ID set up by the printer driver.

¢ Date / Time: The date and time when jobs were sent from the computer.
¢ File Name: The names of files stored in the machine.

& Note
O Depending on the security settings, certain print jobs may not be displayed.

g Select the file you want to print by pressing it.

& Note

O To select all print jobs, press [Select All Jobs].

O Press [4 Prev.] or [V Next.] to scroll through the list.
O If you have already set a password, enter it to print.

O To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].

O To view details about a selected print file, press [Details].

[ press [Print].
A confirmation screen appears.

& Note
O If you have already set a password, proceed to the following step.
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ﬂ] Enter a password using the number keys on the password screen, and then
press [OK]

& Note

O A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

O If you have not set the password, proceed to the following step.

[ press [Ves].
The stored file is printed.

& Note
O Press [No] to cancel printing.

O To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

O Stored Print files sent to the machine is not deleted unless you delete them
in the machine or select [Auto Delete Stored Print Jobs] (see "System", Printer
Reference). For details, see p.94 “Deleting a Stored Print File”.

Deleting a Stored Print File

If a printed document is not as required, you can delete the stored print file.

B o the machine's control panel, press the [ Printer] key to display the printer
screen.

g Press [Print Jobs].
A list of print files stored in the machine appears.

B press [stored Print Job List].
A list of stored print files stored in the machine appears.

ﬂ Select the file you want to delete by pressing it.

& Note
O Press [4 Prev.] or [V Next.] to scroll through the list.

O To cancel a selection, press the highlighted job again.

B Press [Delete].
A confirmation screen appears.



Printing a Document

E Press [Yes].
After the file is deleted, the printer screen reappears.

& Note
O Press [No] to cancel the delete request.

O If you have already set a password in the printer driver, enter it to delete.

How to Use Document Server

Follow the procedure below to print a document using the Document Server function.

& Note
O An optional hard disk drive is required to use the Document Server function.

Windows 95/ 98 / Me

I] In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

g Select the printer, and then click [Properties].
B Click the [Setup] tab.

ﬂ In the [Job Type:] list, click [Document Server].
B click [petails...].

B Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

U crick [ok].
ﬂ Start the printing from the application's [Print] dialog box.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

I] In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.

& Note

O If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.

O If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

E] Click the [Job Log] tab.
ﬂ In the [Job Type:] list, click [Document Server].

B Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

(3 ciick [ok).

& Note
O If you are using Windows 2000, perform the following steps.

ﬂ Start the printing from the application's [Print] dialog box.

Mac OS / Mac OS X

? Limitation
O If you are using Mac OS X 10.1.x, this function cannot be used.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

ﬂ In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

g In the pop-up menu, click [Job Log].
B On the [Job Type:] pop-up menu, click [Document Server].

ﬂ Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

H Start the printing from the application's [Print] dialog box.
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User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [User Code] on the [Statistics] tab.

Windows 2000 / XP, [User ID:] on the [Job Log] tab in the Printing Preferences

Windows Server 2003 dialog box.

Windows NT 4.0 [User ID:] on the [Job Log] tab in the Document Defaults
dialog box.

Mac OS [User ID:] on [Job Log] in the print dialog box.

Mac OS X [User Code:] on [Job Log] in the print dialog box.

A Reference

For details about using SmartDeviceMonitor for Admin, see Help.

Paper Selection

All Pages and Destination Tabs

Use this to select the media type and input tray.

? Limitation

O This function is for Windows 95 / 98 / Me only.

A Reference
For details about the [All Pages] and [Destination] tabs. See the printer driver's Help.
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Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Size:] on the [Paper] tab.
Windows 2000 / XP, [Paper Size:] on [Paper/Output] on [Advanced...] on the [Pa-
Windows Server 2003 per/Quality] tab in the Printing Preference dialog box.
Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document De-
faults dialog box.
Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dia-
log box.
Mac OS X [Paper Size:] in the Page Setup dialog box.
A Reference
For details about the paper sizes supported by this machine, see General Set-
ting Guide.
Fit to Paper

When the size of the document and paper size differ, set whether or not to print

according to paper size.

Windows 95 / 98 / Me [Fit to Print Size:] on the [Paper] tab.

Windows 2000 / XP, [Fitto Paper:] on [Printer Features] on [Document Options] on

Windows Server 2003 [Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab
in the Document Defaults dialog box.

Mac OS [Fitto Paper:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Fit to Paper:] on the [Features x] tab on [Printer Features] in
the print dialog box.

++ Prompt User

Print is performed with the size of document to be printed unchanged.

< Nearest Size and Scale

If the paper size is smaller than the selected paper size, the driver reduces the

print size.

If the paper size is larger than the size of document to be printed, print is not

to fit the paper size.

% Nearest Size and Crop

When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.
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Input Slot

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Input Tray:] on the [Paper] tab.
Windows 2000 / XP, [Paper Source] on the [Paper/Quality] tab in the Printing
Windows Server 2003 Preferences dialog box.
Windows NT 4.0 The [Page Setup] tab in the Document Defaults dialog
box.

Mac OS [Paper Source:] on [General] in the print dialog box.
Mac OS X [Paper Feed] in the print dialog box.

A Reference

For details about the paper sources, see Printer Reference.

Resolution

Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Resolution] on the [Print Quality] tab.

Windows 2000 / XP, [Resolution] on [Graphic] on the [Paper/Quality] or [Layout]

Windows Server 2003 tab in the Printing Preferences dialog box.

Windows NT 4.0 [Graphic] on the [Advanced] tab in the Document Defaults
dialog box.

Mac OS [Resolution] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Resolution] on the [Features x] tab on [Printer Features] in
the print dialog box.

A Reference

For more information about the resolution types, see Printer Reference.
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Print Mode (Toner Saving )

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Toner Saving] on the [Print Quality] tab.

Windows 2000 / XP,

[Print Mode:] on [Printer Features] on [Advanced...] on the

Windows Server 2003 [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Print Mode:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Print Mode:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Print Mode:] on the [Features x] tab on [Printer Features] in
the print dialog box.

A Reference

For details about this function, see Printer Reference.

Duplex Printing

Use this function to select duplex printing.

? Limitation

O To use this function, the optional duplex unit must be installed on the machine.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Duplex:] on the [Setup] tab.

Windows 2000 / XP,

[Print on Both Sides (Duplex)] on the [Layout] tab in the

Windows Server 2003 Printing Preferences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab
in the Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The [Print on both Sides] check box on [Duplex:] in the print

dialog box.

You can select the following items: The following items may vary depending on
the operating system you are using.
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Windows 95/98 / Me

o
*

*

Off
Disables Duplex Printing.

< Open to Left
Prints output so that you can open it to the left.

% Open to Top
Prints output so that you can open it to the top.

Windows 2000 / XP, Windows Server 2003, Mac OS, Mac OS X

& Note

O If you are using a Mac OS, click to select the button that means “Flip on Long
Edge” or “Flip on Short Edge”.

% None
Disables Duplex Printing.

« Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.

+ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.

Windows NT 4.0

< None
Disables Duplex Printing.

< Short Side

Prints output so that you can open it to the short edge when bound along the
short edge.

% Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.
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Gradation

Use this to select a type of gradation based on your purpose.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Print Quality] tab.

Windows 2000 / XP, [Printer Features] on [Advanced...] on the [Paper/Quality] tab

Windows Server 2003 in the Printing Preferences dialog box.

Windows NT 4.0 [Document Options] on the [Advanced] tab in the Document
Defaults dialog box.

Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features x] tab on [Printer Features] in
the print dialog box.

A Reference

For details about the gradation types, see Printer Reference.
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Collate

Use this function to enable collation. With this feature, the machine can efficient-
ly print collated sets of multiple-page documents.

? Limitation
O To use this function, a memory unit of at least 192 MB or hard disk drive must
be installed on the machine.

O If you are using Windows 2000, Windows XP, Mac OS or Mac OS X, make
sure that the following check boxes have not been selected.

e Windows 2000
The [Collate] check box on [Printer Features] on [Advanced...] on the [Paper/
Quality] tab in the Printing Preferences dialog box.

e Windows XP
The [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/ Qual-
ity] tab in the Printing Preferences dialog box.

¢ Mac OS
The [Collate] check box in the print dialog box.

¢ MacOSX
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Collate:]on the [Setup] tab.

Windows 2000, Windows XP [Collate:] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Collate:] on [Printer Features] on [Document Options] on the
[Advanced] tab in the Document Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Collate:] on the [Feature 1] tab on [Printer Feature] in the

printer dialog box.
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Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Type:] on the [Paper] tab.

Windows 2000 / XP, [Media:] on the [Paper/Quality] tab in the Printing Prefer-

Windows Server 2003 ence dialog box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document De-
faults dialog box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Paper Type] on the [Features x] tab on [Printer Features] in
the print dialog box.

A Reference

For details about the media type supported by this machine, see General Set-

ting Guide.

Destination Tray

The following table shows where you can select this function.

Windows 95 / 98 / Me [Output Tray:] in the [Paper] tab.

Windows 2000 / XP, [Destination] in [Printer Features] on [Advanced...] on the [Pa-

Windows Server 2003 per/Quality] or [Layout] tab.

Windows NT 4.0 [Destination] in [Printer Features] on [Document Options] on
the [Advanced] tab.

Mac OS [Destination] in [Printer Specific Options] in the print dialog
box.

Mac OS X [Destination]on the [Features x] tab in [Printer Features] in
the print dialog box.

A Reference

For details about the destination tray supported by this machine, see General

Setting Guide.
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Staple

Use this function to staple sheets of printed paper together.

? Limitation

O When stapling, use the finisher option. See General Setting Guide or Printer Ref-

ererce.

& Note

O The stapling location might differ depending on the orientation of the ma-
chine set in the printer and the orientation of the data to be printed. For de-

tails, see Printer Reference.

The following table shows where you can select this function.

Windows 95 / 98 / Me [Staple:] on the [Setup] tab.

Windows 2000 / XP, [Staple:] in [Printer Features] on [Advanced...] on the [Pa-

Windows Server 2003 per/Quality] or [Layout] tab.

Windows NT 4.0 [Staple:] in [Printer Features] on [Document Options] on the
[Advanced] tab.

Mac OS [Staple:] in [Printer Specific Options] in the print dialog box.
Mac OS X [Staple:] on the [Features x] tab in [Printer Features] in the
print dialog box.

Punch

Use this function to punch holes in the printed documents.

? Limitation

O When punching holes, use the finisher option. See Printer Reference.

& Note

O Punch positions and the number of punch holes that are available will change
depending on the type of finisher, the original's orientation, and the printing
paper size and orientation. For details, see Printer Reference.

The following table shows where you can select this function.

Windows 95 / 98 / Me

[Punch:] on the [Setup] tab.

Windows 2000 / XP,

[Punch:] in [Printer Features] on [Advanced...] on the [Pa-

Windows Server 2003 per/Quality] or [Layout] tab.

Windows NT 4.0 [Punch:] in [Printer Features] on [Document Options] on the
[Advanced] tab.

Mac OS [Punch:] in [Printer Specific Options] in the print dialog box.

Mac OS X [Punch:] on the [Features x] tab in[Printer Features] in the

print dialog box.
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Watermark

Set the Watermark function.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark:] on [Printer Features] on [Advanced...] on the

Windows Server 2003 [Paper/Quality] or [Layout] tab in the Printing Preferences
dialog box.

Windows NT 4.0 [Watermark:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

Watermark Text

Select the Watermark Text type.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark Text:] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Text:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Watermark Font

Select the Watermark Font type.

& Note
O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,

see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark Font:] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Font:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.




Printing a Document

Watermark Size

Select the Watermark Size size.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark Size:] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Size:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Watermark Angle

Select the Watermark angle.

? Limitation

O This item is only for portrait, not for landscape.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark Angle:] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Angle:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.
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Watermark Style

Select the Watermark style.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, [Watermark Style:] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Style:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Dithering

Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Dithering:] on the [Print Quality] tab.

Windows 2000 / XP, [Dithering:] on [Printer Features] on [Advanced...] on the [Pa-

Windows Server 2003 per/Quality] or [Layout] tab in the Printing Preferences di-
alog box.

Windows NT 4.0 [Dithering:] on [Document Options] on the [Advanced] tab in
the Document Defaults dialog box.

Mac OS [Dithering:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Dithering:] on the [Features x] tab on [Printer Features] in
the print dialog box.

You can select the following items:

< Auto
Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

+ Photographic
Performs dithering using an appropriate pattern for photographs.

% Text
Performs dithering using an appropriate pattern for text.

% User Settinglmage Smoothing
Use this setting to print images set in half tone in your application.
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Image Smoothing

Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Image Smoothing] on the [Print Quality] tab.

Windows 2000 / XP, [Image Smoothing] on [Printer Features] on [Advanced...] on

Windows Server 2003 the [Paper/Quality] or [Layout]tab in the Printing Preferenc-
es dialog box.

Windows NT 4.0 [Image Smoothing] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Image Smoothing] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Image Smoothing] on the [Features x] tab on [Printer Fea-

tures] in the print dialog box.

< Off

Disables image smoothing.
< On

Performs image smoothing unconditionally.
«» Auto

Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

% Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

& Note
O When [Auto] is selected, data processing may take a long time.

O When Image Smoothing is used for a mask image, this function may have an
undesired effect on the print result.
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e
4. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

? Limitation

O If a Macintosh and printer are connected by USB, you cannot use Printer Util-
ity for Mac.

& Note

O Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers
and Utilities”.

O Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic en-
vironment is supported.)

O Printer Utility for Mac cannot use Mac OS X (native mode).

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.
B start the Mac Os.

B insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

ﬂ Double-click the [Mac OS] folder.

& Note
[ Under Mac OS X, double-click the [Mac OS X] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Print-
er Utility for Mac] file, and then drop it into the Macintosh hard disk.

E Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Mac OS

i@*lmportant
O Before starting Printer Utility for Mac, make sure the printer is selected in
[Chooser] on the Apple menu.

[I Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B click [ok].
Printer Utility for Mac will take a few seconds to start.

Mac OS X

[l Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.
B click [ok).
8 In the [Available Printers:] box, select the printer you want to use.

& Note
O If you change zones, select a name from [Available Network Zones:].

O Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

I] Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

E Click [Choose].
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

< File menu

[Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.114 “Download-
ing PS Fonts”.

[Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See p.115 “Displaying Printer's Fonts”.

[Initialize Printer's Disk...]

Initialize the printer's hard disk drive. See p.116 “Initializing the Printer
Disk”.

[Page Setup...]

Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.116 “Page Setup”.

[Print Fonts Catalog...]
Print the names of available fonts. See p.116 “Printing Fonts Catalog”.

[Print Fonts Sample...]
Print a sample of fonts. See p.117 “Printing Fonts Sample”.

[Rename Printer...]

Change the printer's name when viewed via Appletalk. See p.117 “Renam-
ing the Printer”.

[Restart Printer]

Restart the printer. See p.118 “Restarting the Printer”.

« Utility menu

[Download PostScript File...]
Download a PostScript file. See p.118 “Downloading PostScript Files”.

[Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.119
“Selecting the Zone”.

[Display Printer Status...]
Display the status of the printer. See p.120 “Displaying the Printer Status”.

[Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See
p-120 “Launching the Dialogue Console”.
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

ﬂlmportant
O The following procedures to download the fonts assume that you are a system
administrator. If you are not, be sure to consult your system administrator.

O If the printer restarts, all the printer settings return to their defaults.
O Confirm that a Mac OS and the printer are connected with Appletalk.

& Note
O Some fonts cannot be downloaded.

O Before downloading, read the documentation about the fonts you want to use.
ﬂ Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

B Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

B click [pownload].
The fonts begin to download, and the download status is shown.

iﬁklmportant
O During the download, do not turn off the power switch, operate the panel
or open or close the cover.

E When the completion message appears, click [OK].
t click [cancel].
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Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.

& Note
O The fonts displayed in italics are the default fonts.

ﬂ Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

g Select [Printer's memory] or [Printer's disk].
H click [oki.

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

B select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

ﬂ Select [Printer's memory] or [Printer's disk].
B Select the fonts you want to delete.

? Limitation
O You cannot delete the fonts displayed in italic.

O click [pelete].
A confirmation message appears.

ﬂ Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

[3 click [Continue], and then click [OK].
U crick [oK].

115



116

Printer Utility for Mac

Initializing the Printer Disk

When initializing the printer's hard disk drive, all the fonts downloaded to the
printer's hard disk drive are deleted. Before initializing, be sure to check the
fonts on the hard disk drive.

iﬁklmportant

O When initializing the printer's hard disk drive from the operation panel, all of
the data on the printer's hard disk drive is deleted. Before initializing, be sure
to check the data on the hard disk drive.

I] Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

& Note
3 To cancel initialization, click [Cancel].

g Click [Execute].
Initializing starts.

ﬂlmportant
O Do not turn off the power switch until initializing is completed, otherwise

the hard disk drive might be damaged.
B When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

[l Select [Page Setup...] on the [File] menu.
B Choose the paper size.

Printing Fonts Catalog

Print the names of fonts available on the printer.

& Note
O The paper selected under [Page Setup] is used.

I] Select [Print Fonts Catalogue] on the [File] menu.
B click print].
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Printing Fonts Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

& Note
O Print by using the paper selected on [Page Setup].

ﬂ Select [Print Fonts Sample...] on the [File] menu.
B ciick print).

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

i@klmportant
O You can enter up to 31 digits and letters.

Y AN II:II II@II IINII
4 . 4 4

4

O Do not use symbols, for example

Mac OS

I] On the [File] menu, click [Rename Printer...].
g In the [New Name:] filed enter a new name.

B Click [Rename].
The printer name is changed.

O click [oK].
B On the Apple menu, click [Chooser].
(3 click the [AdobePS] icon.

ﬂ Select the printer whose name you changed, and then close the [Chooser] di-
alog box.

& Note
O If there are several Appletalk zones, select the zone the machine belongs to.

Mac OS X

I] On the [File] menu, click [Rename Printer...].

g In the [New Name:] filed enter a new name.
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B Click [Rename].
The printer name is changed.

O click [oK].
E On the [Printer Utility for Mac] menu, click [Choose Printer...].
B In the [Available Network Zones:] list, select the zone for the Macintosh in use.

ﬂ In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.
B select [Restart Printer] on the [File] menu.

ﬂ Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.

& Note
O The fonts that you downloaded in the printer's memory will be deleted.

O If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.
I] Select [Download PostScript File...] on the [Utility] menu.

g Select the file name to download and click the file name, and then click
[Open].

B Type the log file name, and then click [Save...].

The selected file is downloaded.

& Note
O Errors are recorded in the log file.



Printer Utility for Mac Functions

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

ﬂlmportant
O Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

[I On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

ﬂ Select the zone in which you want to locate the printer, and then click
[Change].

A confirmation message appears.

B Click [Continue].
A confirmation message appears.

O click [oK].

H On the Apple menu, click [Chooser].

[ ciick the [AdobePs] icon.

ﬂ In the [Appletalk zone:] list, select the zone you changed.

E] In the [Select a PostScript Printer:] list, select the printer you want to use.
g Close the [Chooser] dialog box.

Mac OS X

[I On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

ﬂ Select the zone which you want to locate the printer in, and then click
[Change].

A confirmation message appears.

B Click [Continue].
A confirmation message appears.

O click [oK].
E On the [Printer Utility for Mac] menu, click [Choose Printer...].

E In the [Available Network Zones:] list, select the zone you changed.
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Printer Utility for Mac

ﬂ In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

[l Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

B Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs to.

E) crick [ok).

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

i@klmportant
O “Launch Dialogue Console” is recommended for users with an understand-
ing of PostScript.

O Do not download any file other than PostScript files to the printer.

O “Launch Dialogue Console” must be used at your own responsibility.

I] Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

g Type the PostScript command in the editor screen.

& Note
O To edit a PostScript file, select [Open] on the [File] menu to open it.

O You can search or replace a character string by using the [Search] menu.
B After editing the PostScript file, select [Download Top Window] on [Console]

menu to start printing.

The PostScript file is sent to the printer.

& Note

O The [Reply from Printer] box opens, depending on the PostScript file you
sent.

ﬂ Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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